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Office 2000: A Tool for Project-based Learning 

By Jane Nissen Laidley, Ph.D.   

Open-mindedness, whole-heartedness or absorbed thought, and responsibility in facing 
consequences are three attitudes that John Dewey believed contribute to the habit of thinking. (How 
We Think, 1933) As educators today, our concern is to foster that habit, developing our students 
into life-long learners equipped with a curiosity and the accompanying analytical skills to take charge 
of whatever learning they need to do, whenever they need to do it. To that end, our students are 
more involved in project-based learning than ever before.  

Technology is an effective facilitator of this approach when it is integrated into the curriculum. 
Project-based learning has four components: explore, create, communicate, and reflect. This article 
notes ways in which Microsoft® Office 2000 can be an integral part of a project-centered classroom.  

Explore 

When students explore new topics, they conduct research, interviews, and experiments 
independently as well as collaboratively in small groups. The power of project-based learning begins 
here: how independent and self-sufficient can students be with regard to their own learning?  

In developing their projects, students use software applications to facilitate many aspects of the 
learning process. To this end, Office 2000 provides improvements in ease-of-use and the Help 
system.  

When students encounter a question regarding a software feature, the Microsoft Office Assistant, 
part of the Help system, guides them toward finding the answer on their own. Context-sensitive tips 
and wizards help students complete specific tasks, providing solutions directly within the applications 
they are using. Students can also query the Help system by asking natural-language questions. By 
enabling students to answer questions independently, Office 2000 fosters the development of 
important problem-solving skills.  

The explosion of Internet access in schools and homes has opened the research and inquiry process 
to a seemingly infinite number of resources. The gift of worldwide access to experts and research 
data challenges us and our students to become keen and responsible researchers. Office 2000 helps 
students organize and manage their research.  

To document their work, students use the Notes feature of Outlook® 2000 messaging and 
collaboration client, keeping track of and organizing the information they gather. If students are 
gathering and responding to information from a peer in another country, they may find it practical to 
correspond in the international student's native language. The Language AutoDetect feature in Office 
2000 automatically recognizes the language that the students are using and provides language-
specific spelling and grammar correction tools. With this resource at their fingertips, students can 
confidently explore the diversity of other cultures.  

Create 

Once they've collected their data, students evaluate, analyze, and organize the material. They 
decide how they will eventually present their results. Will it be a written report, a hands-on 
demonstration, a multimedia slide show, or will they post it to a Web site? Do they need graphs and 
charts? An audio component? Artwork? Video? The power of project-based learning lies in the 
freedom students have to take risks and make changes, to look at the complexity of their data and 
match it to the opportunities for presentation.  
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For younger students, the intricacies of creating and formatting documents can present a daunting 
challenge. Imagine how much easier it would be if your students could begin a writing project by 
simply entering text where they would like it to appear. Envision a drop-down menu that displays 
not just a list of font names but the way the fonts appear in the document. Using Word 2000's Click 
N Type feature, students can double-click any location on the page to begin typing there, eliminating 
the need for tabs and carriage returns. To select a new font, students display the drop-down fonts 
menu on the toolbar and preview the fonts before choosing one. Office 2000 enables students to 
give free rein to their imaginations in laying out ideas on the printed page while still focusing on the 
organization and content of their work.  

An important part of project-based learning is the construction and assimilation of knowledge. In 
creating a document, students incorporate several pieces of data gathered during the exploration 
phase. To assemble the data, they can use the Collect and Paste feature, gathering information from 
multiple sources simultaneously, then organizing that information in a meaningful order. Because 
the document can be easily revised and updated, according to a peer review cycle or as new 
information is discovered, technology can encourage students to revisit their work and reach for the 
excellence that satisfies them.  

Communicate 

Next, students deliver their work for review by a larger audience. This can be an oral report to 
another small group or to the whole class, with or without a multimedia component. Student work 
can be posted to a school or district intranet, or to a Web site for worldwide access.  

PowerPoint® 2000 presentation graphics program offers students a dynamic medium with flexible 
editing tools in which to create their presentation. Students can use the Tri-Pane view in PowerPoint 
2000 to view multiple representations of a single concept. If they want to reposition a slide in a 
presentation and add a table for clarity, students can drag and drop the slide to its new location in 
the outline section of the view and update its content by drawing the table directly over the slide, 
visually creating rows and columns. Once the creation process is complete, students can broadcast 
the presentation to other students in the school as well as to the World Wide Web. Whatever the 
venue, the sense of publishing to a real audience provides an valuable incentive for students to take 
pride in and ensure the quality of their work.  

Reflect 

When a project-based learning event comes to a close, students take time to reflect on their 
experience. What did they already know that made this project easy? What new skills did they have 
to acquire? What would they like the teacher to do differently next time? How would they assess 
their collaborative work with other students? What do they want to learn next? This exercise can be 
done independently, as an Outlook 2000 Journal entry; it can be done in the same small groups that 
worked together; or it can be done with the whole class. This is the time when students take the 
intellectual responsibility for their own knowledge and ongoing inquiry that Dewey mentions.  

Clearly, technology can be infused into project-based learning events in transparent ways. The point 
is to create a classroom environment full of enthusiasm for discovery and learning and provide the 
tools to carry out the learning. And, note that Donald Graves reminds us in one of his stories about 
teaching and learning (How to Catch a Shark, 1998), "We were hanging around with a learner, the 
best kind of teacher."  

About the author: For the past 15 years as a writer and curriculum developer, Dr. Laidley's work 
has placed her at the forefront of the infusion of technology into education, creating innovative 
curriculum and training solutions for K-12 teachers and students.  
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Combining Word Files 
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http://www.microsoft.com/education/default.asp?
ID=Combine Files 

Check 
this out! 
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Creating a watermark using Word 

 
 
Add a background or watermark to a printed document 

1. On the Format menu, point to Background, and then click Printed Watermark.  
2. Do one of the following:  

o To insert a picture as a watermark, click Picture Watermark, and then click Select 
Picture. Select the picture you want, and then click Insert.  

o To insert a text watermark, click Text Watermark, and then select or enter the text 
that you want.  

3. Select any additional options that you want, and then click Apply.  

For Help on an option, click the question mark , and then click the option.  

4. To view a watermark as it will appear on the printed page, use print layout view.  

 

Tip 

• If you want to use an object, such as an AutoShape, as a watermark, you can manually paste 
or insert it into the document header. You cannot use the Printed Watermark dialog box to 
control these settings. 

Note   If you want to add a theme, which includes document backgrounds, design elements, and 
color schemes, use the Themes command on the Format menu. 

 
 
 
 

 
Saving as a Template 

 
 
After creating the document you want to save as a template... 
1. Choose "File". 
2. Choose "Save As". 
3. When the Save As... box appears, go down to Save As Type... box. 
4. Click on arrow at the right end of the box. 
5. Scroll down to choose "Document Template". 
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Measuring Readability and Grade Level of Text 
Using Microsoft® Word 

Below are instructions for using Microsoft® Word to measure the grade level of any text you enter. These 
instructions were submitted to the NIFL-Technology listserv on September 14, 2000. 

On MS Word (I use '97) you can do a "Readability" check by following the following steps: 

1.  Click on TOOLS bar. 

2.  Click on SPELLING & GRAMMAR. 

3.  At this window you have to click on OPTIONS. On my version, the LAST option is Show readability statistics.  
Make sure that window is "checked" and any other that you want your SPELL CHECKER to do.  You may want to 
set the "writing style" drop-box for an option other that STANDARD that is more appropriate for your document. 

4. Click OK 

5. Whenever you select SPELL/GRAMMAR for this document, it will take you to all those place the system thinks 
you need to change something.  Most often you IGNORE those suggestions.  At the end of the CHECK, you will 
get a READABILITY STATISTICS table that will tell you (at the bottom) the Flesch-Kincaid Grade level). 

Flesch Reading Ease Score 

Rates text on a 100-point scale; the higher the score, the easier it is to understand the document. For most 
standard documents, aim for a score of approximately 60 to 70. 

The formula for the Flesch Reading Ease score is: 

206.835 – (1.015 x ASL) – (84.6 x ASW) 

where: 

ASL = average sentence length (the number of words divided by the number of sentences) 

ASW = average number of syllables per word (the number of syllables divided by the number of words) 

Klesch-Kincaid Grade Level Score 

Rates text on a U.S. grade-school level. For example, a score of 8.0 means that an eighth grader can 
understand the document. For most standard documents, aim for a score of approximately 7.0 to 8.0. 

The formula for the Flesch-Kincaid Grade Level score is:   

(.39 x ASL) + (11.8 x ASW) – 15.59 

where: 

ASL = average sentence length (the number of words divided by the number of sentences) 

ASW = average number of syllables per word (the number of syllables divided by the number of words) 

http://www.lhup.edu/ablenet/profdev/mtresources.htm 

http://www.lhup.edu/ablenet/profdev/mtresources.htm


Page 7 of 8 

Making Business Cards in Word 

• Click on Tools 
• Click on Letters and Mailings 
• Then on Envelopes and Labels
• Under the Envelopes and 

Labels select the Labels tab. 
 

This area shows the 
current label or 

business card type 
that is set to print for.  
If this does not match 

the paper you are 
using, you can change 

it by clicking on the 
Options button. 

• If you click on Options, you get 
another window 

• Choose your Label or Business Card type 
from the list 

• Click OK 
• Now click on New Document and you 

have a page ready to edit! 
• IF your new document does not display 

a table, you can either: 

• Apply a border to it.  Click on Format…Borders 
& Shading… then choose the borders you want

• Check to see if your table gridlines are turned 
off.  Click on the Table menu, then see if you 
have the option to Show Gridlines. 
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Ideas for Microsoft Word 
 

 
 

Newsletter 
Memo 

Letterhead 
Calendar 

Story Starter Template 
Book Report 

Book Report Covers 
Bookmark 

Vocabulary/Math Problem Bingo 
Certificates 
Brochure 

Multiple Choice Test 
Short Answer Test 

True/False Test 
Timeline 
Outline 

Fliers/Signs 
Assignment Sheet 
Graphic Organizer 

Seating Chart 
Presentation 

Review Games 
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